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SECTION 1 

INTRODUCTION 
& GIS CONCEPTS 
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Welcome 

• Introduction 
– Instructor: Katie Newcomb, GIS Analyst 

• Attendee Introductions 
– Your Name 
– Department or Group 
– What you do 
– Any prior GIS experience? 
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Logistics 

• Schedule 
– Begin 8:30 AM 
– Breaks at least every 90 minutes 
– Lunch from about Noon to 1:00 PM 
– Finish by 5:00 PM or sooner 

• Facilities 
– Refreshments provided 
– Break Room with refrigerator and additional coffee 
– Restrooms in hallway down from elevators 
– Telephones – available, please ask 
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About REGIS 
• GIS Consortium made up of twenty participants 
• REGIS Participants include 

– 9 cities and 1 village 
– 7 townships 
– 3 other organizations like KCRC, ITP and GVMC 

• Officially kicked off September 1997 
• Officially debuted December 2001 
• Provides access to applications, data and support 
• Help to understand how GIS can be used in your organization 
• Agency staff are your GIS staff 
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What is a GIS? 

• An integration of five basic components 
– People 
– Data 
– Hardware 
– Software 
– Procedures 
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Map Scale 
• Map scale determines the size and shape of features 

 

• Large scale 
 
 
 
 
 

• Small scale 
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Components of Geographic Data 
• Three general components of geographic information 
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Overview of REGIS GIS Applications 
• Increasing functionality from ArcGIS Server (eREGIS) to 

ArcView and ArcEditor 

ArcMap 
Citrix web plugin 

needed 

Public 
Members only 

 

Microsoft Silverlight needed 
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Getting “Online” Help 
• Within ArcGIS 

application 
• Contents tab 
• Index tab 
• Search tab 
• Other help 
• REGIS Help 

Desk 
– Telephone 
– E-mail 
– Fax 
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SECTION 2 

LOGGING IN 
& NAVIGATION 
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Accessing the REGIS Environment 
• Web-based login screen 
• Use any popular web browser 
• Access to all REGIS-based 

applications 

http://192.168.10.38/Citrix/Metaframe/ 
or 

https://csg.gvmc-regis.org/Citrix/XenApp/  
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Launch the ArcView 10 Application 
• Application screen 
• All REGIS-based applications 

you have access to 
• Single-click to access 
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What’s New with the ArcMap 10 Interface 

● Icons are more polished  
and easier on the eyes 
 

ArcCatalog, and 
Search tool 

** Important: REGIS Custom Toolbar will not 
change  

 
 

●Easier Access to ArcCatalog and other tools     
 
●Autohide, ArcCatalog, Table of Contents, 
Tables and Stack Windows 
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Data View or Layout View 
• Data view for display, queries, editing and analysis 
• Layout view for creating map layouts 
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Layers, Data Frames and Maps 
• Layer 

– Represents symbolized 
spatial data; formerly called 
“themes” 
 
 
 
 

• Data frame 
– Organizes layers 

• Map 
– Contains data frames, layers 

and map elements 

Data frame 
Layers 
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Layers 
• Reference spatial data sources 
• Set symbols, labels and other properties 
• Manipulate through context menu 
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Adding Data Layers 
• REGIS Layer Manager 

 
 
 
 
 
 
 
 

• Add Data button 
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Data Frames 

• Data frames are containers 
for layers 

• Maps can have many data 
frames 
– Index and inset maps 
– Arrange in Layout view 

• Add from Insert menu 
• Activate data frames to view 

from context menu 
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Maps 
• Hold layers, data frames, graphics and map elements 
• Store information in a map document (MXD) file 
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Managing the Table of Contents 
• Drag layers up or down to 

change display order 
– Smart defaults for layer draw 

order 
• Points, lines or polygons 

– Layers draw in the Table of 
Contents in order, from the 
bottom up 

• Rename data frames and layers 
• Remove layers 
• Display tab or Source tab 
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Moving Around the Map 
• Zoom in or out 
• Pan the display 
• Full extents 
• Back or forward one display 
• Zoom to a layer 
• Zoom to selected features 
• Go To XY Command 
• Navigate maps with mouse 

wheel 
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Using a Bookmark 
• Spatial bookmarks 

– Set and name a location 
extent 

– Return to it at any time in 
that map document 

• My Places 
– Located in the Data Frames 

Toolbar 
– Store frequently used 

locations 
– Access from any map 

document 
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Scale-dependent Display 

• Display layers at specific scale range 
– Reduces clutter and drawing time 
– Layer display property 
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Magnifier and Viewer Windows 
• See more detail or overview 

without changing display 

Create Viewer Window 
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Layer Symbology in ArcMap 
• Same symbol for all features 
• Based on attribute values 
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Labeling Features 
• Label features dynamically using attribute values 
• Layer properties control appearance and position 
• Convert labels to annotation features 
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SECTION 3 

QUERYING 
DATA 
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REGIS QuickSearch: PPN, Owner, & Parcel Address 

• Search directly from the toolbar 
• No need to build complicated query strings 
• Selects appropriate parcel(s) and zooms in 

Enter PPN as one 
long number string— 

do not use dashes 

Enter parcel owner 
name 

as indicated on tax 
records— 

or just a partial name 

Enter parcel address; 
e.g. 40 Pearl St NW  
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Identifying 
• Pop-up attributes for a specific 

feature 
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Finding 
• Locate a specific feature or attribute 

Robinson Rd flashes 
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Geocoding 
• Types of geocoding 

– Single address geocoding 
– Multiple address geocoding 

 
• Geocoding targets 

– Parcels 
– Street centerlines 

Single Multiple 
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Geocoding: Single Address 
• Use the Find tool in the  

Tools toolbar 
• Locations tab 
• For Finding a Single Address use 

one of the following locators  
– Parcel address geocoder 
– Street address geocoder 
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Geocoding: Single Address 
• Addresses 

– Use as MANY address 
components as you possibly 
can: 

• Building Number (e.g. “40”) 
• Street Name (e.g. “Pearl”) 
• Street Suffix (e.g. “St”) 
• Street Directional (e.g. 

“NW”) 
– Zone (optional, streets): ZIP 

Code 
• Street Intersections 

– Components (same as 
above) 

– Link two street names with 
“&” 

– “Ottawa Ave NW & Pearl St 
NW” 
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Geocoding: Parcel Number 
• Use the Find tool in the 

Tools toolbar 
• Locations tab 
• For Finding a Parcel by the 

Parcel Number use one of 
the following locators  
– PPN geocoder 
– Dashed PPN gecoder 
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Geocoding: Parcel Number 
• PPN (packed) 

– 12 digits and nothing else 
 

• PPN (dashed) 
– 12 digits separated by 

dashes 
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Geocoding: Multiple Addresses 
• Choose input address file 
• Select address field 
• Select output file 
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Geocoding: Multiple Addresses 
• Match success: geocoding result 
• Status, score, side 
• Review/Rematch addresses 

– Match interactively 
– Match automatically 
– Done 
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Measuring 
• Find linear distances 
• Find area of a polygon 
• Click on feature to get distance, 

area, xy coordinates 
• Snap to features 
• Running total 
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Map Tips 
• Display the property of a layer 
• Map tips 

– Pointer location displays specific 
attribute 
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REGIS Mailing Labels 
• Quick and easy way to generate 

mailing labels 
• Accommodates up to three 

different types 
– Owner name and address 
– Taxpayer (lien holder) name 

and address 
– Occupant address 

• Include or exclude PPN 
• Export results to Excel 

Parcels must  be 
highlighted 
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Calculating Acreage 
• Select 

– Features 
– Calculator icon 

in toolbar 
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SECTION 4 

MAPS AND 
LAYOUTS 
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Creating Maps in ArcMap 
• Design in Layout view 
• Data frames organize 

layers 
• Map elements are 

added to a virtual page 
• Maps stored as .mxd 

files 
– Data location 
– Layer properties 

Data frame Title Neatline 

Legend 

North 
arrow 

Logo Scale 
bar 

Data 
frame Virtual 

page 
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Setting up the Page 
• Remember the purpose 

– Will the map be viewed 
up close or at a 
distance? 

– What is the best page 
size? 

– Landscape or portrait? 
– What printer will I be 

using and what are my 
printer size limitations? 
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Identifying Map Elements 
 

• What is missing? 
Title 

Map body 

Legend 

North arrow Scale bar Other text 
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Inserting Map Elements 

 Choose type 

 Legend appears 

 Drag 

 Modify 
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Example of Legend Properties Dialog 
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Adding a North Arrow and a Scale 

• Change angle, size and 
color 

• Choose type, unit 
increments, color and font 



October 2012 REGIS Intermediate GIS 10 Training Manual 52 

Inserting Textual Information 
• Title and author 
• Data source, date, projection 
• Date of map 
• Disclosures and 

acknowledgements 

same 
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Layout Tools 
• Zoom and pan the layout page 

 
 
 
 
 
 
 

 
 
 

• Additional layout settings from 
Tools > Options 
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Printing and Plotting Maps 

Windows 
printer engine 

Choose a printer engine 
ArcPress 
PostScript 
Windows 
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Exporting Maps as Digital Files 
• Export from Layout view, not Data view! 
• Exports all elements from layout, not just map 
• Export to raster (.gif, .jpeg, .tiff) or PDF formats 
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SECTION 5 

OTHER APPLICATIONS 
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ArcGIS Extensions: Brief Overview 
• Spatial Analyst 

– Find suitable locations or the best path between them 
– Perform integrated raster/vector analysis 
– Perform distance and cost-of-travel analysis 
– Perform statistical analysis based on the local environment, small neighborhoods, 

or zones 
– Generate new data using simple image processing tools 
– Interpolate data values for a study area based on samples 
– Clean up a variety of data for further analysis or display  

• Network Analyst 
– Conduct drive-time analysis, point-to-point routing, route directions, service area 

definition, shortest path, optimum route, closest facility or origin-destination 
analysis  

• 3D Analyst 
– Create three-dimensional views directly using your GIS data 
– Analyze three-dimensional data using cut/fill, line-of-sight and terrain modeling 
– View your data from a global to local perspective 
– Navigate through multi-resolution terrain data seamlessly 
– Do spatial analysis in two or three dimensions 
– Visualize modeling or analysis results in three-dimensions 
– Use three-dimensional models and symbols for realism 
– Export your visualizations into videos  
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ArcGIS Extensions: Brief Overview 
• Publisher 

– Easily provide interactive maps to your clients 
– Protect your maps, including cartography and data, from inappropriate use  
– Control how your published maps are used and who uses them  
– Create rich interactive maps that meet your clients' needs  
– Provide efficient and controlled access to your enterprise GIS data  
– Easily package the required data and maps for distribution  
– Build custom map viewers for your maps  

• Maplex 
– Place more and better labels 
– Reduce manual editing time using intelligent annotation placement  
– Produce clearer maps that better communicate findings  

 



Exercise 2.1 – Starting ArcView 

In this exercise, you will learn how to: 
 Log in to the web-based REGIS environment 
 Launch the ArcView 10 application 

Setup 
From your desktop computer, open a web browser such as Internet Explorer or 
Firefox. 

Starting ArcView Tutorial 
1. In your web browser, type in one of the following URL addresses exactly 

as it appears below.  Depending on how your community or agency 
accesses REGIS, you will only type one of the following addresses.  
Contact REGIS or your local REGIS coordinator for assistance. 
 
http://192.168.10.38/Citrix/Metaframe/   
or 
https://csg.gvmc-regis.org/Citrix/XenApp/ 
 

2. In the REGIS Application Web Interface, enter your REGIS User ID and 
password into the Username and Password fields.  Press Log In. 

 

  
 

3. The first time you log in to REGIS, you will be prompted to change your 
password to something of your own choosing.  Enter a new password and 
continue with the log in.   
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4. Logging in successfully will display the REGIS Applications screen.  Here 
you will be presented with the REGIS applications you may access.  
Single-click on the ArcView 10 icon and wait for the program to launch.  It 
may take several minutes for the application to open. 
 

 
 
 

5. ArcView’s mapping application, ArcMap, will appear.  The ArcMap 
interface may load with a window in front of it that includes a box entitled 
Arc Map – Getting Started.  Click the REGIS Templates option and 
press OK. 
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Additional Information 
 
If you do not have a REGIS user account, contact the REGIS Help Desk. If you 
forget your password, call the REGIS Help Desk for assistance.  While REGIS 
personnel do not have access to your password, they can reset it for you. For 
other types of issues related to the REGIS Application Web Interface, contact the 
REGIS Help Desk using the contact information below. 
 
REGIS Help Desk 
 

 Telephone: (616) 776-7744 
o Monday-Friday 8:30am –Noon, 1:00pm – 5:00pm 
o Off-hours, including weekends and holidays, feel free to leave a 

message 
o REGIS Agency staff will attempt to resolve your problem within one 

business day – often within a few hours or a few minutes! 
 E-mail: regis@gvmc.org  

o E-mail support is good for non-time-sensitive issues 
o REGIS Agency staff will respond via e-mail or telephone generally 

within one day or sooner. 
 Fax: (616) 774-9292 

o If you need to fax documents to REGIS Agency staff, please be 
sure to label them “ATTN: REGIS Help Desk” or “ATTN: Staff 
Member Name” 

 
Note that you may want to contact your local Information Technology (IT) or 
Computer Help personnel first since your question or problem may be due to a 
local computer or network issue. 
 

End of Exercise 2.1 
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Exercise 2.2 – Exploring the ArcMap Interface 

In this exercise, you will learn how to: 
 Understand the ArcMap interface and terminology 
 Customize ArcMap by moving around toolbars 
 Turn toolbars and the table of contents on or off 
 Access the help documentation 

Setup 
Log in to the REGIS Application Web Interface and launch the ArcView 10 
program. 

Exploring the ArcMap Interface Tutorial 
The ArcMap interface consists of several components:   

 
 

 Map-data Area (Data View)  – The majority of the program’s window is 
devoted to the Data View for displaying the digital map-data layers.  Each 
time a new ArcMap window is opened, the area will be blank since no data 
has been added yet.  This is also commonly referred to as simply the 
“map.” 
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1. Notice in the bottom-left corner of the Data View there are four 
small buttons. The first button is selected to indicate 
the display area is in the Data View. 
 

2. Select the page icon  to switch from Data View to Layout View.  
A map page-layout is displayed.  This Layout View is used to create 
and print maps in ArcMap. 
 

 Table of Contents (TOC) – Positioned on the left side of the Data View 
(unless you change the default location – discussed below) is the Table of 
Contents.  The TOC lists all the data layers in the Data View.  The first 
time ArcMap is opened or when a new map project is started, the TOC will 
be empty except for the Layers data frame icon.  

 
1. Change the width of the Table of Contents by moving your mouse 

cursor to right edge of the TOC and wait for the resize icon to 
appear. Drag the border left or right to change the size.  This may 
be necessary to see the entire names of the data layers you will 
add. 
 

2. Turn off the Table of Contents (which can happen by accident on 
occasion) by left-clicking on the x in the upper-right corner.   

 Turn it back on by going to the 
Window menu item at the top of the screen and choosing Table of 
Contents. 
 

 
3. Many ArcMap components, including the Table of Contents, are 

“dockable”.  This means they can be moved around the interface 
and docked somewhere else.  For example, at the top of the TOC, 
double-click  .  The TOC should 
now become undocked and capable of being moved around the 
screen by left-clicking and dragging.  When it approaches another 
location, the outline of the TOC changes shape as it tries to fit in to 
that location. 
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4. Return the TOC to its original location by moving it there or double-
clicking again on . 

 
 Toolbars – In addition to the Data View and the Table of Contents, 

ArcMap also contains a number of buttons at the top and bottom of the 
screen.  These buttons are first separated on toolbars based on similar or 
related functionality.  Then each toolbar is further divided by more specific 

functions.  Each within-toolbar group begins with an icon  and then 
displays a suite of related icons.  The following are some of the common 
toolbars. 

 
Main Menu 

  
Standard Menu 

  
Tools 

 
 

1. Each toolbar is also dockable so briefly test moving around the 
toolbars and docking them in different spots.  To undock a toolbar, 
left-click and hold on the left edge of the toolbar and drag it 
somewhere else.   
 

2. Toolbars can be turned off by clicking on the small x  that 
appears when a toolbar is not docked.  To turn a toolbar back on, 
go to the Customize menu, select Toolbars and choose the name 
of the toolbar to turn back on.  Notice that ArcMap contains dozens 
of other toolbars that are turned off but can be used in special 
circumstances. 

 

 
 

 
 REGIS Toolbar – REGIS has created their own toolbar that will usually 

appear at the bottom of the ArcMap window. 
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Getting Help and Technical Support 
1. ESRI, the software developer of ArcGIS, offers several outlets for 

getting help and documentation on using ArcMap software.   
a. The ArcGIS Desktop Help manual can be accessed in the 

Help dropdown menu or through the keyboard shortcut F1 
within ArcGIS. 

 

 
 
 
b. The ArcGIS Desktop Help manual can also be accessed by 

returning to the REGIS Application Web Interface and selecting 
it from the list of applications. 

 

 
 

2. Use the Contents, FavoritesIndex and Search tabs to find a section of 
interest.  For example, select the Search tab and type data view.  
Notice that the topic has many sections.  Left-click on the section 
named displaying maps in data view and layout view. 
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3. Another location for technical support is the ESRI Support Center.  
Open a web browser and enter the URL support.esri.com.  The search 
box on the top of the screen provides a quick way to search the entire 
support site for information on your question. 
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Additional Information 
See the Mapping and visualization in ArcMap section in the ArcGIS Desktop 
Help manual. 
 

 
 
See the Customizing the user interface section in the ArcGIS Desktop Help 
manual. 
 

 
 

End of Exercise 2.2 
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Exercise 2.3 – Adding and Managing Data Layers 

In this exercise, you will learn how to: 
 Add and remove data layers to ArcMap 
 Rearrange, rename and copy data layers 
 Add and remove data frames 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10. 

Adding and Managing Data Layers Tutorial 

1. Press the NPS Theme Manager button  in the REGIS toolbar (bottom 
of screen).  A Theme Manager window is displayed. Expand REGIS 
Themes; this shows all the possible REGIS data layers grouped into 
categories. 

 

 
 

2. In the Basic Layers folder, select the Basic Layers (Group Layer) by left-
clicking and dragging it onto the map.  Once added, the layers will appear 
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individually in the Table of Contents (TOC). 
 

 
 

3. The order of the layers in the TOC determines how they are displayed in 
the Data View.  Rearrange the layers by left-clicking and holding on a 
layer name and then dragging it up or down in the list. 
 

4. Layers can be turned on or off individually by selecting the checkbox  
next to their name.  For bulk changes, right-click on the data frame name 
and choose Turn All Layers On or Turn All Layers Off. 
 

   
 

5. Rename a map layer by highlighting it in the TOC and pressing F2.  For 
example, highlight the Street Centerlines layer, press F2, and rename it to 
Roads. 
 

   
 

6. Rename the data frame in the same manner – highlight it, press F2 and 
change the name to something more appropriate. 
 

   
 

7. Remove a layer from the map by right-clicking on a layer name and 
selecting Remove.  This and other actions can also be undone by going to 
the Edit menu and selecting Undo. 
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8. Add a second data frame to ArcMap by going to the Insert menu and 
choosing Data Frame.  Multiple data frames are often used when printing 
page layouts that have multiple maps on the same page. 
 

 
 
 

9. Return to the layers in the first data frame and find the Parcels layer.  
Right-click on the layer name and select Copy. 
 
 

 
 
 

10. Back in the newly added data frame, right-click on the data frame name 
and choose Paste Layer(s).  The Parcels layer has now been added to 
the second data frame. 
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11. To go back to viewing data from the first data frame, right-click on that 
name and choose Activate.  Notice how the data frame name-text 
switches to bold. 
 
 

 
 
 
 
 

12. Remove the second data frame by right-clicking on it and choosing 
Remove. 
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Additional Information 
See the Working with layers section in the ArcGIS Desktop Help manual. 
 

 
 

 
End of Exercise 2.3 
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Exercise 2.4 – Moving Around the Map 

In this exercise, you will learn how to: 
 Use the map navigation controls in ArcMap 
 Set the full extent of your map to a specific government unit 
 Zoom to a particular latitude/longitude location 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Moving Around the Map Tutorial 
1. Locate the Tools toolbar in the ArcMap interface. 

 

 
 

2. Begin by selecting the Zoom In  tool.  There are two ways to use this 
tool.  First, move the mouse cursor to a location of interest on the map and 
left-click once.  This will zoom in and re-center the map on wherever you 
clicked.  A second option involves drawing a box to zoom into the area of 
the box.  Left-click and hold the zoom cursor on the map, drag the mouse 
to create a rectangle in any direction.  Release the mouse button to zoom 
to the area inside the rectangle you drew. 
 

 
 

3. To pan (i.e., move) the map in any direction, use the Pan  tool.  Left-
click and hold on the map and then drag it any direction. 
 

4. The Zoom Out  tool  works in a similar fashion as the Zoom In tool but 

more often you will probably use the Fixed Zoom Out  tool.  Left-click 
on the tool to zoom farther out at consistent intervals.  Or use the Fixed 
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Zoom In  button to zoom back in on the data.  Finally, use the Full 
Extent  button to return the full extent of all data layers in the data 
frame. 
 

5. The Full Extent button can also be customized to zoom to a specific map 
extent instead of the entire map.  For example, it may be more efficient to 
always return to the extent of your city or township.  First use the Zoom In 

 tool to navigate to the extent of your local unit.  Right-click on the data 
frame name , choose Properties and select the Data Frame tab.  
In the box entitled Extent Used By Full Extent Command, choose the 
Other option and select Specify Extent. 
 

  
 

6. The Full Extent window 
will appear.  Choose the 
Current Visible Extent 
option and Press OK 
twice to return to the 
map.  Navigate 
somewhere else in the 
map and then left-click 

the Full Extent  
button.  Instead of 
zooming to the entire 
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map, it zoomed to the extent you defined.  This will remain in effect until 
you return to the Data Frame tab and switch back to the Extent of data in 
all layers (Default) option. 

 
 

7. The Go Back to Previous Extent  and Go To Next Extent  buttons 
allow you to return to previous extents you had zoomed to in the map.  Try 
this by pressing the Go Back to Previous Extent button several times and 
notice how it returns to views you were just looking at. 
 

8. Additionally, many of the previously mentioned navigation tools can be 
accessed by right-clicking on the map while in the Data View. 

 

 
 

9. Another navigation option is the Go To XY  tool for zooming to an 
exact location.  Left-click on the tool to display the input form. 

 

 
 

10. Use the black down-triangle to select the units Decimal Degrees. 
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11. Enter the following values for longitude and latitude. 
 

 
 

12. Pressing enter immediately converts the input to the degrees-minutes-
seconds format and also zooms and flashes the location on the map.  Use 
the Flash  button to highlight the location again.  Press the Add 
Callout  button to add a text box on top of the data showing the location 
and its coordinates. 
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Additional Information 
See the Moving around the map section of the ArcGIS Desktop Help manual. 
 

 
 

End of Exercise 2.4 
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Exercise 2.5 – Working with Spatial Bookmarks 

In this exercise, you will learn how to: 
 Save ArcMap project files (MXDs) 
 Create and manage spatial bookmarks in an ArcMap project 
 Create and manage spatial bookmarks using My Places 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Creating and Managing Bookmarks Tutorial 
1. Spatial bookmarks can be stored in a specific ArcMap project which we 

will first create.  To save an ArcMap project, go to the File menu and 
choose Save As… 

 

 
 

2. Navigate to a location in your REGIS user directory and name the project, 
in this case use BookmarksDemo.mxd.  All ArcMap project files have the 
MXD file extension and are often referred to as just “MXDs.”   
 

3. Zoom to a particular location in the data that would be logical place for a 
bookmark (e.g., City Hall, subdivision, golf course, lake, etc.).  Go to the 
Bookmarks menu and choose Create. 
 

 
 

4. Enter an appropriate name for the spatial bookmark. 
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5. Press OK and the bookmark has been added to the ArcMap project.  To 

ensure the project is saved with the new bookmark, click the Save  
button. 
 

6. Press the Full Extent  button to return the map to entire extent.  Return 
to the Bookmarks menu again.  Notice that a new entry exists for the 
bookmark you created.  
 

 
 

7. Select the bookmark name and the Data View will be automatically 
zoomed to the location of your bookmark.  It is important to remember that 
these bookmarks are only accessible in this ArcMap project. 
 

8. To remove the bookmark, return to the Bookmarks menu and choose 
Manage.  A Spatial Bookmarks window appears where you can select the 
bookmark name and choose Remove. 
 

 
 

9. ArcMap offers a second option for saving spatial bookmarks call My 
Places.  My Places stores spatial bookmarks in a separate file that can be 
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accessed in any ArcMap project you create.  Go to the Data Frames 
Tools toolbar and select  My Places.   

 
 

10. Add a bookmark to My Places by selecting the Add From button and 
choosing Current Extent. 
 

 
 

11. A new bookmark is created and added to the list named My Place.  Right-
click on the name and select Rename.  Type in an appropriate name for 
the location.  This bookmark will be accessible in any ArcMap project you 
open or create. 
 

   
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12. My Places bookmarks can be zoomed to by selecting one in the list and 
clicking the Zoom To or Pan To buttons.  Use the Remove or Remove 
All buttons to delete places. 

13. Notice that in the Type column, a black and yellow rectangle  
indicates that the bookmark you created is for a map extent.  My Places 
can also store the locations of specific features and addresses.  These 
types of places would appear with different icons as shown below.  My 
Places will be discussed further in upcoming exercises and in the 
Advanced GIS training class. 
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Additional Information 
See the Using spatial bookmarks and Using My Places sections of the ArcGIS 
Desktop Help manual. 
  

 
 
 
 
 
 
 
 
 
 
 

 
End of Exercise 2.5 

 

REGIS Intermediate GIS Training  Exercise 2.5 – Working with Spatial Bookmarks  Page 5 



Exercise 2.6 – Map Scale and Scale-Dependent Display 

In this exercise, you will learn how to: 
 Understand map scale 
 Set the map scale to achieve a specific scale 
 Recognize when a layer has a visible scale range 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Map Scale and Scale-Dependent Display Tutorial 
1. Notice that in the Standard Toolbar there is a drop-down box displaying 

the map scale.  Remember that the scale displayed is a representative 
fraction and not tied to any specific unit of measure.  In the example 
below, the map scale may be read as “1 inch on the map represents 
118,427 inches on the ground” or “1 meter on the map represents 118,427 
meters on the ground.”   
 

 
 

2. Zoom in on the data and notice how the scale ratio increases.  In other 
words, zooming in creates a larger-scale map while zooming out creates 
a smaller-scale map. 
 

       
 

       
 

3. ArcMap also has several predefined, commonly used map scales that can 
be accessed by clicking on the black-down triangle at the right end of the 
scale box.  Choose several different scales in the list and notice how the 
map extent changes based on the scale size. 
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4. You can also enter your own scale by typing a new number into the scale 
box.  You do not have to type the 1: portion as that is added automatically 
after hitting enter.  To try this, type a number into the scale text box and 
press enter. 
 

   
 

5. Often times, engineering plans or other maps will contain map scales such 
as 1 inch = 400 feet.  Zooming to this scale in ArcMap is not as simple as 
typing 400 because there are both inches and feet in the scale.  There are 
two methods for entering this type or scale. 
 
Method 1: The scale must be converted to a representative fraction 
without units.  The easiest approach is to convert the 400 feet to inches. 
 
400 feet x 12 inches per foot = 4,800 inches 
 
1 inch = 4,800 inches or 1:4,800 
 
Typing 4,800 in the scale text box would achieve a scale of 1 inch = 400 
feet. 
 
Method 2: ArcMap can detect unit names in the scale box and will 
perform the necessary conversion.  Both of the following examples would 
be valid inputs. 
 

   

   
 

6. To set 1:4,800 as a permanent option in the scale drop-down box, choose 
the <Customize This List…> option.  
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7. In the Scale Settings window, enter 4,800 in the input box and press Add. 
 

 
 

8. If you have loaded in layers using the REGIS Layer Manager, you may 
notice that some of them turn on or off as you zoom to various scales.  
REGIS has setup these layer with their own visible scale range to avoid 
the situation where a very complex layer, such as Parcels, attempts to 
draw all of its polygons at once when the map is zoomed to a small-scale 
(e.g., 1:200,000).  Instead, ArcMap will hide the layer and indicate this with 
a grayed-out checkbox in the Table of Contents. 
 

 
 

Setting and changing the visible scale range will be discussed in the 
REGIS Advanced GIS training class or see the following additional 
information section. 
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Additional Information 
See the Working with map scales section of the ArcGIS Desktop Help manual. 
 

 
 
See the Displaying layers at certain scales section of the ArcGIS Desktop 
Help manual. 

 
 
 

 
End of Exercise 2.6 
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Exercise 2.7 – Using the Magnifier and Viewer Windows 

In this exercise, you will learn how to: 
 Use the Magnifier and Viewer Windows 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Using the Magnifier and Viewer Windows Tutorial 
1. ArcMap offers a Magnifier Window for viewing a close-up map of a 

specific area without having to zoom in the entire display to that location.  
Turn on the Magnifier Window by going to the Window menu and 
choosing Magnifier. 

 
 

2. A separate magnifier window is displayed on top of the main map showing 
a close-up view of the area it is directly above.  The Magnifier can be 
moved around by left-clicking and holding on the blue title area and then 
dragging it around the map.  The amount of magnification can be changed 
by choosing a percentage in the drop-down box. 
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3. Related to the Magnifier Window is a Viewer Window.  This can be 
turned on by going to the Window menu and choosing Viewer. 
 

 
 

4. When it is first opened, it will display in its window the data at the center of 
the main map. 
 

 
 

5. Unlike the Magnifier, it does not change its view when the window is 
moved.  Instead it relies on its own set of map controls to pan and zoom.  
This allows you to keep a view of a specific area regardless of where you 
navigate in the main map. 

 

 
 

6. Clicking on the black triangle at the upper-right of the Viewer Window 
displays an additional set of controls.  Select each available option and 

note the effect on the main map. 
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Additional Information 
See the Working with magnifier, viewer, and overview windows section in 
the ArcGIS Desktop Help manual. 
 

 
 

 
End of Exercise 2.7 
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Exercise 2.8 – Introduction to Layer Properties 

In this exercise, you will learn how to: 
 Access the layer properties for a data layer 
 Change the symbology of a data layer 
 Turn labeling on or off for a data layer 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Introduction to Layer Properties Tutorial 
1. Each data layer in the Table of Contents (TOC) has an associated set of 

properties that ArcMap uses to display that data in the map.  This set of 
properties can be accessed by right-clicking on a layer name in the TOC 
and choosing Properties. 
 

 
 

REGIS Intermediate GIS Training  Exercise 2.8 – Introduction to Layer Properties  Page 1 



2. A Layer Properties window is displayed with eleven tabs that each 
contain settings related to how the layer is used and displayed in ArcMap.  
Click on each tab and glance at the options available.  This exercise will 
focus only on the Symbology and Labels tabs while the REGIS 
Advanced GIS training class will examine all the tabs. 
  

 
 

3. Locate the Cities & Townships layer in your TOC.  Right-click on the 
name, choose Properties, and then Select the Symbology tab.  This tab 
sets the layer’s display colors on the map.  In this example, all the 
Government Unit polygons are displayed with no fill color and yellow 
outline. 
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4. To change the symbology, left-click on the Symbol graphic  to bring 
up the Symbol Selector window. 
 
 

 
 

5. On the left-side is a listing of predefined coloring schemes that can be 
chosen.  For example, select the Rose option and notice how the Preview 
and Options boxes on the right-had side are updated to reflect the chosen 
symbology. 
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6. In the Options box, the symbology settings can also be customized.  The 
Fill Color and Outline Color can be changed by selecting the black 
down-triangle and choosing a new color.  The Outline Width can also be 
adjusted in size.   

 
 

7. Press OK to set the new symbology and then press OK again to update 
the map with the new colors. 
 

8. The TOC also offers a shortcut to changing a layer’s symbology.  Left-click 
once on the small symbology icon just below the layer’s name to go 
directly to the Symbol Selector menu. 
 

 
 

9. Labeling features are also controlled in the Layer Properties.  Find the 
Primary & Residential layer in the TOC, right-click on the name, and chose 
Properties.  Select the Labels tab. 
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10. Notice the first checkbox that reads Label features in this layer.  If this 
box is checked, labels will be displayed on the map.  If the box is checked, 
uncheck the box and press OK to return to the map.  Turning labels on 
and off is controlled by simply checking or un-checking the box.  The 
Labels tab will be discussed in more detail in the Advanced GIS training 
class.   
 

11. There is also a shortcut for turning labels on or off.  After right-clicking on 
a layer name in the TOC, there is a Label Features option that displays a 
checkbox when labeling is turned on.  If it is missing, left-click on the Label 
Features text and the checkbox will be added and the map will draw the 
labels. 

   

Additional Information 
See the About labeling section of the ArcGIS Desktop Help manual. 
 

 
 
 

End of Exercise 2.8 
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Exercise 3.1 – Identifying Features 

In this exercise, you will learn how to: 
 Use the Identify tool to obtain attribute information about the data layers 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Identifying Features Tutorial 

1. Locate the Identify Features   button on the Tools toolbar, left-click on it 
and then the map to activate.  It should display the Identify window without 
anything inside it. 

 
 

2. Since there are usually multiple data layers in your data frame, it is 
sometimes necessary to first inform the Identify tool which layer you will 
be querying.  Use the Identify from drop-down box to pick the layer of 
interest.  For this exercise, select the Parcels layer from the list of layers.  
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3. Return to the map and left-click inside a parcel of interest.  The Identify 
window will refresh showing the selected parcel attributes. Each field 
name is displayed along with its corresponding value in the GIS database. 
 

 
 

4. Features can also be identified by drawing a rectangle on the map. Return 
to the map, left-click and hold and draw a rectangle around a group of 
parcels. Releasing the mouse button will identify all parcels that intersect 
the identify rectangle. The Identify window now will contain a list of those 
parcels. The selected feature in the list will have its attributes displayed. 
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5. Move the mouse cursor back over the map. Hold down SHIFT or CTRL 
and a small  icon will appear next to the mouse cursor.  While still 
holding down SHIFT or CTRL, left-click inside additional parcels and they 
will be added to the Identify window without removing your previous 
selections. 
 

6. When a group of features are listed in the Identify window, it may be 
helpful to get a sense of where they are located in the map. Right-click on 
the layer name in the left side and choose Flash.  All the features in the 
list are flashed on the map. There is also a Create Bookmark option to 
create a spatial bookmark of the overall location. These options (e.g., 
Flash, Create Bookmark, etc.) are also available by right-clicking on 
individual features in the list. 
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7. In the filed column of the Identify window, you can right-click and view 
several additional options. Choosing Copy allows you to copy an attribute 
value and paste it into a Word document, Excel spreadsheet or another 
Windows application. Choosing Sort Fields will rearrange the fields 
alphabetically. Choosing Hide Fields(s) will remove a field from the 
display while Unhide Fields will add all hidden fields back to the display. 
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MapTips Tutorial 
1. Move your mouse cursor over a parcel feature. After pausing, a box will 

appear next to your cursor displaying the parcel number. This is a MapTip 
that has been set up in the Parcels layer by REGIS. It provides a quicker 
way to view attribute information than using the Identify window. Other 
REGIS data layers may have MapTips enabled as well. The Advanced 
GIS Training class will discuss MapTips in more detail. 

 

 

 

Additional Information 
See the Identifying features and Displaying MapTips sections of the ArcGIS 
Desktop Help manual. 
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End of Exercise 3.1 
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Exercise 3.2 – Finding Features 

In this exercise, you will learn how to: 
 Use the Find tool to search data layers and find specific features 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Finding Features Tutorial 

1. Locate the Find  button on the Tools toolbar.  Double click to display 
the Find window. 
 

 
 

2. To speed up the search, it is best to first choose a layer and a specific 
field to search.  Use the In drop-down box to select the layer you will be 
searching.  In this exercise, select Primary & Residential in the Street 
Centerline layer.  Then select the In field option and choose the field 
named Street Name. 
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3. Now in the Find box, enter a full or partial street name such as barclay.  
Press the Find button and the tool will search the Street Centerlines layer 
and display all segments that have barclay in the name.  
 

 
 

4. In this search, five results are returned.  Even though there is only one 
street named BARCLAY, the GIS contains five segments because the 
centerline is split at several intersections.  To zoom to the entire street, all 
of the results need to be highlighted in the list.  Either hold down SHIFT or 
CTRL and select them one at a time or draw a box by left-clicking and 
holding around them all.  Then right-click in the highlighted area and select 
Zoom To.  The map will zoom to the entire street and flash the location of 
the segments. 
 
 

REGIS Intermediate GIS Training  Exercise 3.2 – Finding Features  Page 2 



 
 
 

 
 

5. Another option with the Find results is the ability to identify them from the 
results window.  With all the results still highlighted right-click and choose 
Identify. 
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6. The Identify window is displayed with all the search results listed in the 
window. 

 
 

7. Return to the Find button and select the Places tab.  If you have an 
internet connection, you can also search for places using ESRI’s online 
database.  Choose the World Gazetteer ESRI service and search for a 
place name like Grand Rapids, MI.  
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8. Right-click on the result and select Zoom To and the map will zoom to the 
entire extent of the City of Grand Rapids. 

Additional Information 
See the Using the Find tool section of the ArcGIS Desktop Help manual. 
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End of Exercise 3.2 
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Exercise 3.3 – Geocoding 

In this exercise, you will learn how to: 
 Use the Find button to locate addresses, parcels and intersections 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Geocoding Tutorial 
1. Select the Find  button on the Tools toolbar to open the Find window. 

 

 
 

2. Choose the Locations tab. Click on the drop-down icon  to the right of 
the box entitled Choose an Address Locator.  You can choose from 
several types of locators depending on your intended use. For this 
example choose Street Address Geocoder.  
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3. If the Street Address Geocoder is not listed in the drop down. Add the 
locator by selecting the folder button next to the drop down. All locators 
are on the I:\ Drive at the end of the folder list. Scroll to the end of the list 
and choose Street Address Geocoder. 

 
 
 
 
 
 
 
 
 
 
 
 

  
 

4. In the Street or Intersection text box, enter a complete address such as 
40 Pearl St NW. 
 

 
 

5. To better understand the Geocoding process, select the Show 
Standardization button  to view how your search input 
is being interpreted.  Notice how the number (40), street name (PEARL), 
suffix type (ST), and suffix direction (NW) have been separated into their 
appropriate categories.  If the Find tool had misinterpreted your input, you 
could correct it in this Edit Standardization window. 
 

 
 

6. Close the Edit Standardization window and press the Find button to 
search for the address within the street centerline address ranges.  The 
search results will appear at the bottom of the Find window with each 
possible candidate ranked by their matching score.  In most cases, the 
result with the higher score (100 is a perfect match) is the correct location 
of the address.  Right-click on the entry with the score of 100 and choose 
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Zoom To. 
 

 
 
 

7. In the background, the map will zoom to and flash a point at the address 
location.  Since this geocode was based on the street centerline address 
ranges, the location may not be exact but usually is close enough for most 
circumstances.  It may be helpful to move the Find window to the corner of 
the screen and use the Flash option to see the location again. 
 

 
8. Right-click on the result in the Find window again and choose Add Point.  

This will add a black dot on the map showing the address location.  Notice 
that the dot is offset from the street centerlines by 60 feet on the correct 
side of the street.  This 60 foot offset is added by REGIS to assist in 
placing an address as close as possible to its exact location. 
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9. To compare those results to a parcel address geocode, use the drop-
down icon to choose a new Address Locator.  Select the Parcel Address 
Geocoding.  Type the same address as before and press the Find button 
to view the results. The parcel-based geocode returns possible matching 
parcels with the exact or similar addresses.  The correct parcel received a 
perfect score of 100 while parcels with similar addresses might be 
returned but with much lower scores. 
 

 
10. Right-click on the correct result and choose Zoom To.  Next choose the 

Add Point option.  The map should now display a second black dot at the 
center of the parcel.  Notice the difference between the results of a street 
and parcel-based geocode. 
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11. If the address is a location that you will return to often, it may be helpful to 
store the address in your My Places.  Right-click on the result and choose 
Add to My Places. 
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12. Open My Places (found in the Data Frame Tools Toolbar). The address 
you choose will now appear as a place alongside other spatial bookmarks 
you have saved.  Notice that is appears with a dot icon to indicate it is a 
specific location. 
 

 
 

13. The Find tool can also locate intersections if the Streets Address 
Geocoding locator is selected.  Use the drop-down icon to select the 
Street Address Geocoding locator. 

 
 
14. In the Street or Intersection box, enter the complete names of two 

streets separated by the ampersand (&) character.  
 

 
 
 

15. Again select the Show Standardization button.  Notice how the search 
input has been separated into two streets and their appropriate 
components (e.g., name suffix type, suffix direction) have been identified. 
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16. Close the Edit Standardization window and press Find.  The intersection 
of Ionia Ave NW and Pearl ST NW appears as the first result with a 
perfect score of 100. 
 

 
 

17.  Right-clicking on the intersection has the same options as the address 
results.  Select the Zoom To, Flash, and Add Point choices and observe 
the results. 
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18. Geocoding in ArcMap does not have to accept exact inputs.  To test this, 
change the Street or Intersection input to read ionia nw & pearl nw. 
 

 
 
 

19. Pressing Find now produces the same result except the matching score 
has decreased to 69.  Removing the street suffixes didn’t prevent the 
intersection to be located but it did significantly lower the match score.  
Experiment with partial addresses and intersections to gain an 
understanding of the Geocoding process. Also test what happens when a 
street name is misspelled. 
 

 
 

Additional Information 
See the Geocoding and address management section of the ArcGIS Desktop 
Help manual. 
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End of Exercise 3.3 
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Exercise 3.4 – Measuring 

In this exercise, you will learn how to: 
 Use the Measure tool to find lengths, perimeters and areas in ArcMap 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Measuring Tutorial 
1. Select the Measure  tool on the Tools toolbar.  The Measure window 

will appear in the upper-left corner of your Data View. 
 

 
 

2. By default, the Measure Line  option will be selected.  This allows you 
to measure linear distances on the map.  Begin a measurement by left-
clicking on the map and then move the mouse cursor to another location.   
A gray line is drawn from the starting location to wherever the cursor is 
while the Measure window is updated with the current length of the 
segment. 
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3. To change direction and continue measuring, left-click once and move the 
cursor again.  The gray measure line changes direction and the Measure 
window now displays the distances of your current segment and total 
length of both segments.   
 

 
 

4. To end the measurement, double-click the left mouse button.  The 
measure line disappears but the distances in the Measure window remain 
until a new measurement is performed or the box is closed.  The 
measurements can be copied and pasted into other applications if 
needed. 
 

5. To measure an area, choose the Measure An Area  option in the 
Measure window.  Return to the map and draw a shape on the map by 
left-clicking to create each corner of the polygon.  Double-click on the last 
corner of the shape to finish the area measurement.  The Measure 
window will be updated with the last segment length, perimeter and area 
of the shape. 
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6. The third measure option is to measure a specific feature in the map.  
Select the Measure A Feature  button in the Measure window.     
 

7. Locate a street centerline segment in your map.  Move the measure 
cursor over it and left-click.  The Measure window will update with the 
segment’s length. 
 

 
 

8. Find a parcel in the map and left-click on it.  The Measure window will 
display the area and perimeter of the parcel.  It is important to note that 
nowhere in the Measure window does it specify that the Parcels layer was 
the layer clicked upon.  It is the user’s responsibility to make sure they 
have measured the appropriate feature.  If the click location is inside 
multiple polygons of different layer types, the layer on top in the Table of 
Contents will be measured. 
 

 
 

9. The units of measure can be changed by selecting the Units  icon and 
choosing Distance or Area.  For example, change the Area units to Acres 
and identify another parcel. 
 

  
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Additional Information 
See the Measuring distances and areas section of the ArcGIS Desktop Help 
manual. 
 

 
 

End of Exercise 3.4 
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Exercise 3.5 – Using the REGIS Quick Search Tools 

In this exercise, you will learn how to: 
 Use the REGIS toolbar to perform parcel number and parcel owner 

searches 
 Use the REGIS Acreage Calculator to find the acreage of a selected 

parcel 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Parcels data layer to the 
data frame.  

Using the REGIS Quick Search Tools Tutorial 
1. The REGIS toolbar contains the ability to quickly search for parcel 

numbers by its PPN, owner names  or street address . 
 

 
 

2. In the PPN text box, enter a parcel number as one long number without 
any dashes.   

 
 
3. Press the Enter key and the tool will locate the parcel and zoom to that 

location on the map.  The parcel will appear with a turquoise boundary to 
indicate it has been selected. 
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4. In the Owner text box, enter the name of a parcel owner as listed on the 
tax records. 

 
 
 

5. Press Search and the tool will find the owner’s parcel and zoom to it on 
the map.  The parcel will again appear with a turquoise boundary to 
indicate that it has been selected. 
 

 
 

6. In the Parcel_Address text box, enter an address. This will search only 
the parcel data for a match. A complete address includes all of the 
necessary components: building or house number, full and proper street 
name, street suffix (e.g. St, Rd, Blvd, Ave, Dr, etc.) and, if the address is 
within most areas of Kent County, the suffix is directional.  

 

 
 

7. Press Search and the tool will find the parcel that matches that address 
and zoom to it on the map.  The parcel will again appear with a turquoise 
boundary to indicate that it has been selected. 
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8. While a parcel is still selected (as shown by the turquoise boundary), the 
REGIS toolbar offers a quick way to calculate the acreage of that parcel.  
Select the Acreage Calculator on the REGIS toolbar to display the 
acreage. 
 

   
 

9. Use the Clear Selected Features  button on the Tools toolbar to clear 
the parcel selection (i.e., remove the turquoise boundary).  The concept of 
selecting features will be discussed in more detail in the Advanced GIS 
training class. 

 

Additional Information 
For assistance with the REGIS Quick Search tools, contact the REGIS Help 
Desk. 

 
End of Exercise 3.5 
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Exercise 3.6 – Creating REGIS Mailing Labels 

In this exercise, you will learn how to: 
 Perform a parcel selection in ArcMap 
 Use the REGIS toolbar to create mailing labels 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Parcels data layer to data 
frame.  

Creating REGIS Mailing Labels Tutorial 
 The first three steps describe the concept of selecting features in ArcMap.  It is 
briefly discussed here for the purposes of creating mailing labels but is covered 
in more detail in the Advanced GIS training class. 
 

1. Select the Select Features  tool on the Tools toolbar. 
 

2. In the Table of Contents, right-click on the Parcels layer and choose 
Selection…Make This The Only Selectable Layer. 
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3. Move your mouse cursor onto the map and find a group of parcels.  Left-
click and hold to draw a rectangle around these parcels, release the 
mouse button, and they will be selected.  The selected parcels appear in 
the map with turquoise boundaries. 
 

 
 

4. The Parcels layer must also be highlighted in the Table of Contents for the 
REGIS Mailing Labels tool to function correctly.  Left-click once on the 
layer name to highlight it and change its appearance to a dark blue 
background with white text. 
 

   
 

5. With the Parcels layer highlighted in the Table of Contents, click the 
Generate Mailing Labels  button on the REGIS toolbar. 
 

 
 

6. The Mailing Label Generator window will appear and allow you to 
choose what label types (e.g., Property Owner, Resident, Taxpayer) will 
be created.  There is also an option as to whether or not to include the 
parcel number on the mailing labels, and an option to export to Excel. 
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7. Press OK to create the mailing labels.  The tool will launch Microsoft Word 
with the labels created and ready to print. 
 

 
 

8. If necessary, you can save the mailing labels to your own network folder 
for future reference.  Choose Save As... from the File menu. 
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Additional Information 
For assistance with the REGIS Mailing Labels tool, contact the REGIS Help 
Desk. 
 
See the Selecting features interactively section in the ArcGIS Desktop Help 
manual. 
 

 
 
 

End of Exercise 3.6 
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Exercise 3.7 – Accessing Linked Documents 

In this exercise, you will learn how to: 
 Use the REGIS Access Linked Documents tool 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to data frame.  Also add the Sewer Manholes and Sewer Mains data 
layers to the data frame. 

Accessing Linked Documents Tutorial 
1. Highlight the Sewer Mains layer in the Table of Contents by left-clicking 

once on the name.  The highlighted layer will appear with a dark blue 
background and white text.  Then zoom in on the map until you are close 
enough to see individual sewer mains. 
 

 
 

2. Select the Access Linked Documents  tool found on the REGIS 
toolbar. Return to the map and left-click and hold to draw a box through 
or completely around a sewer main.  Release the mouse button after the 
sewer main is entirely inside the box. 
 

REGIS Intermediate GIS Training  Exercise 3.7 – Accessing Linked Documents  Page 1 



 
 

3. A Documents to View window will appear showing documents that are 
linked to the sewer main feature you choose.  Select a file name in the list 
and press OK.  The linked document will open automatically in the 
appropriate viewer program (usually Adobe Reader). 
 

 
 

4. The document can be printed or saved to your own directory by choosing 
the Save a Copy option in the File menu. 
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Additional Information 
For assistance with the Access Linked Documents tool, contact the REGIS Help 
Desk. 
 

End of Exercise 3.7 
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Exercise 4.1 – Page Setup in ArcMap 

In this exercise, you will learn how to: 
 Switch between the Data View and Page View 
 Choose a printer and page size for your map 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  

Page Setup in ArcMap Tutorial 
1. Notice in the bottom-left corner of the map area that there are four small 

buttons.  The first button should be selected to indicate the 
map-data area is in the Data View.  Select the page icon  to switch from 
Data View to Layout View.  An alternative way of switching between 
views is going to the View menu and choosing Layout View.   
 

 
 

2. The Layout View displays how your 
map will look when it is printed or 
exported.  The data frame containing 
your layers is still displayed but 
within the outline of a page.  The 
default page size is a standard 8.5” x 
11” sheet of paper.  Verify this by 
glancing at the Rulers that appear 
on the top and left sides.  
Additionally, notice there are two 
borders on the page.  The thick 
black line indicates the page 
boundary while the dotted gray line 
represents the printer margins.  It is 
best to keep all page elements within 
the dotted gray line to avoid clipping errors when printing. 
 
 
 

3. To change the page size or orientation, go to the File menu and choose 
Page and Print Setup. 
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4. Chose an appropriate printer in the Printer Setup box.  Then pick from 
the available paper sizes in the Size drop-down box.  Lastly pick a page 
orientation.  For this exercise, switch from Portrait to Landscape. 
 

 
 

5. Find the checkbox at the bottom of the Page and Print Setup window 
entitled Scale Map Elements proportionally to changes in Page Size.  
It is good practice to check this box anytime you change the page size or 
orientation to ensure your map elements are adjusted and resized to stay 
within the page margins. 

 
 

6. Press OK to close the Page and Print Setup window.  The Layout View 
will be adjusted to landscape and your data frame will be resized to stay 
inside the margins. 
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7. Use the Select Elements  tool on the Tools toolbar to left-click and 
hold inside your data frame to drag it over to the left side of the page.  Use 
the blue adjustment squares  that appear at the corners and sides of the 
data frame to resize it.  Left-click and hold on a square  and drag it to 
another location. 
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Additional Information 
See the Getting started with layout out and printing maps section of the 
ArcGIS Desktop Help manual. 
 

 
 
 

End of Exercise 4.1 
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Exercise 4.2 – Moving Around the Page 

In this exercise, you will learn how to: 
 Use the Layout toolbar to move around the Layout View 
 Navigate inside your Data View while in Layout View 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  Switch from the Data View to the Layout View. 

Moving Around the Page Tutorial 
1. Locate the Layout toolbar in your ArcMap interface.  If it is not visible, turn 

it on by going to the View menu and choosing Toolbars…Layout.  The 
Layout toolbar is used to navigate the page layout and does not affect 
your data frame or data layers in any way. 
 

 
 

2. Select the Zoom In  tool to zoom in on the page.  You can either left-
click once to zoom in or left-click and hold to draw a rectangle to zoom to.  

The Zoom Out  tool works in a similar manner for zooming out from the 
page. 
 

3. Another approach to zooming is to use the Fixed Zoom In  or Fixed 
Zoom Out  buttons.  Left-click the buttons to zoom the page in or out at 

a fixed interval.  Use the Zoom Whole Page  button to return to the full 
extent of the page layout. 
 

4. Use the Pan  tool to move around the page.  Left-click and hold and 
then drag the cursor to a different location.   
 

5. Use the Go back to extent  and Go forward to extent  buttons to 
cycle between previous page layout extents. 
 

6. It is still possible to navigate inside your data frame while in the page 

layout.  Use the standard navigation tools  to zoom 
and pan around your data frame.  This is useful for making small 
adjustments to the extent of the data that is displayed on your page.  For 
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more extensive map changes, it is best to return to the Data View. 
 

7. Switch back and forth between the Data View and Page View.   
Notice that the map scale in the scale box  changes slightly 
between the two views.  This change occurs because of the difference in 
relative proportions (i.e., height and width) between your Data View as it 
appears on your monitor and the size of your data frame on the page 
layout.  To illustrate why this is important to be aware of, return to the 
Data View and enter an “inches to feet” scale like 1 inch = 400 feet.  
Pressing the Enter key will convert the scale to the appropriate 
representative fraction (1:4800).  Now switch to Layout View and notice 
that the map scale has changed.  In the example below, this would 
present a problem if it went unnoticed and a map was provided to 
someone who thought the scale was 1 inch = 400 feet when in fact it was 
1 inch = 555.4 feet (i.e., 1:6,665).  The solution to this is to always enter 
your preferred map scale while in Layout View.  Upcoming exercises 
will illustrate how to add a scale bar and scale text to the map for 
additional forms of verification. 
 

       
 
Additional Information 
See the Layout toolbar buttons section of the ArcGIS Desktop Help manual.  
First select the Index tab and then enter the phrase Layout toolbar buttons.   
 

 
 

End of Exercise 4.2 
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Exercise 4.3 – Inserting Map Elements 

In this exercise, you will learn how to: 
 Add a title, text, north arrow, scale bar, scale text and images to the 

Layout View 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  Switch from the Data View to the Layout View. 

Inserting Map Elements Tutorial 
1. Everything on the page in Layout View is considered 

a map element (or element for short).  The first time 
you access the Layout View the only element is the 
data frame itself.  To modify any element on the page, 

you must first select the Select Elements  tool 
(found on the Tools toolbar) and then left-click on the element.  A selected 
element will appear with a dotted border and blue rectangles at the 
corners and sides. 
 

2. Move an element by left-clicking and holding inside of the element and 
then dragging it to a new location.  Resize an element by left-clicking and 
holding on one of the blue rectangles  and dragging it to a new location. 
 

3. To insert a title for the map, go to the Insert menu and select Title.  A text 
box appears near the top of the page.  Type an appropriate title and press 
enter to finish the title. 

 
 

 
 

4. Use the Select Elements  tool to right-click on the title and select 
Properties.  The Properties window is displayed where the text properties 
can be modified if necessary.  
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5. Press the Change Symbol button to open the Symbol Selector window 
where the font size type, size, color and style can be adjusted.  Change 
the font size from 18 to 28 and select the bold  option.  Press OK twice 
to return to the map. 
 

 
 

6. Additional text can be added by going to the File menu and choosing Map 
Document Properties.  The Select Elements  tool can be used to 
modify the text, change the font properties and move it to a different 
location on the map. 
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7. Go to the Insert menu and choose North Arrow.  The North Arrow 
Selector window appears to allow you to choose from a variety of north 
arrow types.  Select one and press OK to add it to the page.  Adjust its 

size and location using the Select Elements  tool. 
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8. Go to the Insert menu and choose Scale Bar.  The Scale Bar Selector 
window appears and allows you pick from a variety of different types of 
scale bars.  Select one and press OK to add it to the map.  Adjust its size 

and location using the Select Elements  tool. 
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9. The scale bar is linked to your data frame so it will adjust its numbers 
automatically whenever the data frame is zoomed in or out.  To 

demonstrate this, first use the Zoom In  tool button on the Layout 
toolbar to zoom in on the scale bar.  Note the numbers on the scale bar 

and then press the Fixed Zoom In  button for the map found on the 
Tools toolbar.  The scale bar will adjust its numbers to a smaller range. 
 

     
 

10. In addition to a scale bar, scale text (e.g., 1 inch equals 400 feet) can be 
added to map.  Go to the Insert menu and choose Scale Text.  The Scale 
Text Selector window appears and allows you to pick the units involved.  
Most often you will want to select the Inches = Feet option.  Press OK 
and the scale text is added to your map.  Just like the scale bar, the scale 
text is linked to your data frame so experiment with zooming in and out 

using the map zoom tools  and notice how the scale 
text changes. 
 
 

 
 

11. Locate the map scale box and type in 1:4800.  Press Enter and note that 
the scale text on the page layout displays the proper conversion of 1 inch 
equals 400 feet. 
 

   
 

12. Other graphics can be added to the map by going to the Insert menu and 
choosing Picture.  A variety of image formats are supported, including 
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JPEG, GIF, TIFF and PNG.  Navigate to the image location and press 
Open. 
 

13. At this point, your map should have a title, text, north arrow, scale bar, 
scale text and possibly an image.  The last map element to add is the 
legend and this will be discussed in the next exercise. 
 

 
 

Additional Information 
See the Map elements section of the ArcGIS Desktop Help manual. 
 

 
 

 
End of Exercise 4.3 
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Exercise 4.4 – Inserting a Legend 

In this exercise, you will learn how to: 
 Add a map legend to the Layout View 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  Switch from the Data View to the Layout View.  

Inserting a Legend Tutorial 
1. Go to the Insert menu and choose Legend. 

 

 
 

2. The Legend Wizard appears with the first screen asking you to choose 
which layers will be in the legend.  All the data layers in your map appear 
on the left side under Map Layers while the Legend Items list on the right 
side contains the layers that will appear in the legend.  Initially, only the 
layers that are turned on will be listed as legend items but you can use the 
> and >> buttons to move one or all of the layers into the legend.  Click 
Next to continue. 
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3. The Legend Title screen appears and offers you a chance to change the 
title and font style of the legend.  Press Next to continue. 
 

 
 

4. The Legend Frame screen appears and allows you to add a border, 
background color or drop shadow to the legend.  For example, choose a 
thin border with a gray drop shadow.  Press Next to continue. 
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5. The next screen in the Legend wizard gives you the opportunity to change 
size and shape of the symbol that will appear next to the layer name in the 
legend.  For now, just press Next to continue. 
 

6. The final screen allows you to make spacing adjustments for the 
components of the legend.  For now, just press Finish and the legend will 
be added to the Layout View. 
 

7. Use the Select Elements  tool to move the legend to an appropriate 
location on the page and resize it if necessary. 
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8. The legend is fully customizable.  One common adjustment is to reorder 
the layers.  In the example legend above, the Parcels layer is listed below 
the street centerlines layer but you may want to move it above the street 
categories.  Right-click on the legend and select Properties. 
 

9. Select the Items tab on the Legend Properties window.  The order of 
layers in the legend is shown in the Legend Items list box.  Select the 
parcels layer and left-click the up arrow  to move the parcels above the 
street centerlines.  Press OK and the legend is updated. 
 

     
 

10. Another customization option is to change the layer name in the legend.  
For example, in the legend above, the parcels layer is named “Parcels 
(Owners/Site Address).”  It would make more sense to shorten this to just 
Parcels.  The easiest solution is to simply rename the layer in the Table of 
Contents.  Left-click on the layer name to highlight it, press F2, and type a 

REGIS Intermediate GIS Training  Exercise 4.4 – Inserting a Legend  Page 4 



new name for the layer.  The legend will automatically update. 
 

    
 

11. Return to the Legend Properties window and select the Legend tab.  Here 
the legend title can be changed or removed by un-checking the Show 
checkbox.  Also, the size of each legend symbol can be adjusted in the 
Patch box.  For example, change the Width in the text box from 30 to 60 
and press OK. 
 

 
 

   
 

12. Return to the Legend tab again and change the line symbol from 
Horizontal to ZigZag. Press OK and notice how the line symbols change 
their style. 
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   
 

13. To remove the legend or any map element from the Layout View, right-
click on it and select Delete. 
 

 
 

Additional Information 
See the Map elements section of the ArcGIS Desktop Help manual. 
 

 
 

 
End of Exercise 4.4 
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Exercise 4.5 – Printing Maps 

In this exercise, you will learn how to: 
 Print maps in both the Layout and Data Views 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  Switch from the Data View to the Layout View and add 
any additional map elements before printing.  

Printing Maps Tutorial 
1. After you have completed setting up your map elements in the Layout 

View, go to the File menu and choose Print. 
 

 
 

2. The Printer box displays the name of the chosen printer.  If this is 
incorrect, select the Setup button and choose a different printer from the 
Page and Print Setup window. 
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3. The Printer Engine drop-down box should be set to Windows Printer 
already.  Use the Properties button next to it to access the standard 
Windows printer properties to change color settings, paper types, scaling, 
etc.  
 

 
 

4. If your map contains aerial photography, you may want to adjust the 
Output Image Quality box.  Moving the slider to the Best setting will 
increase the resolution of the photos when printed but will also increase 
the printing time and may cause printer memory issues on very large 
maps.  ESRI recommends using the setting between Normal and Best as 
a compromise.  Again, this is only applicable if your data contains aerial 
photography or other raster datasets. 
  

 
 

5. Set the number of copies to be printed in the lower-left corner of the Print 
window. 

 
 

6. The bottom-right side of the Print windows contains a graphic that 
represents how your page layout is going to be printed in relation to the 
printer’s page settings.  Most of the time the image will fill the paper size 
exactly. 
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If for some reason the printer page settings have changed, the graphic 
would indicate the map will not print correctly.  Use the Page and Print 
Setup window to correct the page issue. 

 

 
 
7. Press the OK button to send the map to the printer.  This process may 

take anywhere from several seconds to over 10 minutes depending on the 
size and complexity of the map.   
 

 
 

8. Maps can also be printed from the Data View.  Switch back to the Data 
View  and go to File menu and choose Print.  The Print 
window appears and all the settings and options are the same as printing 
from the Layout View.  The only difference is the printed map will only 
contain the data frame portion and not the additional map elements (e.g., 
legend, scale bar, north arrow, etc.) as shown in the Layout View.  
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Pressing OK will print the data as it appears inside of your Data View and 
it may add surrounding areas to fill the entire page size of the printer. 

Additional Information 
See the Map output section of the ArcGIS Desktop Help manual. 
 

 
 
 

End of Exercise 4.5 
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Exercise 4.6 – Exporting Maps 

In this exercise, you will learn how to: 
 Export maps to image formats such as JPEG, GIF and TIFF 
 Export maps to PDF 
 Control layer visibility in PDF maps 

Setup 
Log in to the REGIS Application Web Interface and launch ArcView 10.  Use the 
Layer Manager button on the REGIS toolbar to add the Basic Layers (Group 
Layer) to the data frame.  Switch to the Layout View and add any additional map 
elements before exporting.  

Exporting Maps Tutorial 
1. Either the Data View or Layout View can be exported to image formats 

such as JPEG, GIF and TIFF.  Go to the File menu and choose Export 
Map. 
 

 
 

2. The Export Map window will appear and allow you to pick a location to 
save the exported map.   Select the drop-down icon next to where it says 
Save in: Choose users$ on ‘Na1’ (I:).  
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3. You will see a series of folders with everyone’s user names. Navigate to 
your username or your community’s folder, and double click.  Use the 
Save as type drop-down box to select a file type.  For this example, 

choose JPEG (*.jpg).  Then enter a file name. 
   

 
 

4. If the Options portion of the window is not shown , click on the 
triangle or the Options text to expand the section.  All image formats will 
have a Resolution box that can be adjusted using the arrows or typing a 
new value into the text box.  Increasing the dpi will increase the file size 
and vice versa.  Resolution often becomes important when you are 
emailing an exported map.  If the file size is too large to email, reducing 
the resolution will decrease the file size.  It may take several exports to 
determine the optimal resolution. 
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5. Press Save to start the export.  The export could take anywhere from 
several seconds to minutes depending on the map size, complexity and 
resolution of the export.  The export progress will be displayed at the far-
left portion of the status bar found at the bottom of the ArcMap interface.  
The status bar will display Export complete when it is finished. 
 

 
 

6. The exported image can be opened in any Windows program that can 
read JPEG images. 
 

 
 

7. Maps can also be exported to PDF.  
Return to the Export Map window and 
choose PDF (*.pdf) as the Save as type. 
 

8. PDF exports also have an Options section 
where the Resolution can be set.  The 
best resolution again depends on the 
circumstances and how the map will be 
used.  Unlike the image format exports, 
there is also an Output Image Quality 
box.  This setting is only used when a 
raster layer like the aerial photographs are 
present in the map.  Increasing it from 
Normal to Best will improve the output 
PDF but increase the file size and vice 
versa. 
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9. Press Save to run the export.  Locate the exported PDF and open it in 
Adobe Reader. 
 

 
 

10. An added feature in PDF exports is the ability to control layer visibility.  If 
the Layers side panel is not visible, go to the View menu and choose 
Navigational Panels and then Layers. 
 

 
 

11. The Abode Reader Layers list should be similar to your ArcMap Table of 
Contents.  Each layer that was turned on in ArcMap for the export will 
show up as an individual item that can be turned on or off in the PDF.  All 
of the other map elements (e.g., legend, scale bar, north arrow, etc.) will 
appear in the Other layer while all the labels on your map will show up in 
the Labels layer.  Click the eye icon  to turn each layer on or off. 
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Additional Information 
See the Exporting a map section of the ArcGIS Desktop Help manual. 
 

 
 

 
End of Exercise 4.6 
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